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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
PICDEM™ 2 Plus Demonstration Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Warranty Registration

• Recommended Reading

• The Microchip Web Site

• Customer Support

• Customer Support

• Revision History

DOCUMENT LAYOUT

This document describes how to use the PICDEM 2 Plus Demonstration Board as a 
development tool to emulate and debug firmware on a target board, as well as how to 
program devices. The document is organized as follows:

• Chapter 1. “Introduction” – Introduces the PICDEM 2 Plus Demonstration 
Board and provides a brief description of the hardware. 

• Chapter 2. “Getting Started” – Goes through a basic step-by-step process for 
getting your PICDEM 2 Plus Demonstration Board up and running as a 
stand-alone board or with an ICE, ICD or PICkit™ programmer. 

• Chapter 3. “Tutorial” – Provides a detailed description of the tutorial program. 

• Appendix A. “Hardware Detail” - Describes in detail the hardware of the 
PICDEM 2 Plus Demonstration Board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2011-2015 Microchip Technology Inc. DS40001584C-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS40001584C-page 6  2011-2015 Microchip Technology Inc.
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending in the Warranty Registration Card entitles users to receive new product 
updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use PICDEM™ 2 Plus Demonstration Board. Other 
useful documents are listed below. The following Microchip documents are available 
and recommended as supplemental reference resources.

Readme Files

For the latest information on using other tools, read the tool-specific Readme files in 
the Readmes subdirectory of the MPLAB IDE installation directory. The Readme files 
contain update information and known issues that may not be included in this user’s 
guide.

PIC16(L)F193X Data Sheet (DS40001364): Consult this document for 
information regarding the PIC1934/6/7 28/40/44-pin Flash-based, 8-bit CMOS 
microcontrollers with XLP technology.

PIC18(L)F2X/4XK22 Data Sheet (DS40001412): Consult this document for 
information regarding the PIC18(L)F2X/4XK22 28/40/44-pin Flash-based, 8-bit CMOS 

microcontrollers with XLP technology.

PIC16(L)F1826/27 Data Sheet (DS40001391): Consult this document for 
information regarding the PIC16(L)F1826/27 28/40/44-pin Flash-based, 8-bit CMOS 
microcontrollers with XLP technology.

TC74 Data Sheet (DS20001462): Consult this document for information regarding 
the TC74 Tiny Serial Digital Thermal Sensor.

MPLAB® X IDE User’s Guide (DS50002027): Consult this document for more 

information pertaining to the installation and features of the MPLAB® X Integrated 

Development Environment (IDE) software.

MPLAB® Code Configurator User Guide (DS40001725): Consult this 
document for more information pertaining to the installation and features of the 

MPLAB® Code Configurator plugin.

MPLAB® PM3 Device Programmer User’s Guide (DS50002278): Consult 
this document for more information pertaining to the features and functions of the 
MPLAB® PM3 Universal Device Programmer.

MPLAB® ICE Emulator User’s Guide (DS50001159): Consult this document 
for more information pertaining to the features and functions of the MPLAB® PM3 
Universal Device Programmer.

MPLAB® ICD 3 In-Circuit Debugger User’s Guide (DS50001766): Consult 
this document for more information pertaining to the features and functions of the 
MPLAB ICD 3 software.
 2011-2015 Microchip Technology Inc. DS40001584C-page 7
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PICkit™ 3 Microcontroller Programmer User’s Guide (DS50002116): 
Consult this document for instructions on how to use the PICkit™ 3 microcontroller 
programmer software and hardware

Refer to the MPLAB Code Configurator web page for further details: 

http://www.microchip.com/pagehandler/en_us/devtools/code_configurator/home.html.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug 
express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and PICkit 
2 and 3.
DS40001584C-page 8  2011-2015 Microchip Technology Inc.
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 

http://www.microchip.com/support.

REVISION HISTORY

Revision A (June 2011)

Initial Release of this Document.

Revision B (September 2011)

Removed references to 4 MHz canned crystal oscillator connected to Y2. Part is not 
part of demonstration board.

Revision C (May 2015)

Updated Figures 2-3, 2-4, 2-7; Updated the Recommended Reading section in Preface 
chapter; Use of MPLAB X and XC8 updated with MCC plugin; Other minor corrections.

Note: This board (DM163022-1) has been updated from the previous version 
(DM163022).The user guide for the previous board version (DM163022) 
can be found online at the PICDEM 2 Plus web site (DS51275) 
www.Microchip.com/PICDEM2PLUS.
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Chapter 1.  Introduction
1.1 INTRODUCTION

Thank you for purchasing the PICDEM™ 2 Plus Demonstration Board from Microchip 
Technology Incorporated. The PICDEM 2 Plus Demonstration Board is a simple board 
that demonstrates the capabilities of Microchip’s 8-bit, 18-, 28- and 40-pin PIC16FXXX, 
PIC16F1XXX, and PIC18 devices.

The PICDEM 2 Plus Demonstration Board can be used stand-alone with a 
programmed part, with an in-circuit emulator (for example, MPLAB® REAL ICE™) or 
with an in-circuit programmer/debugger (such as MPLAB® ICD 3 or PICkit™ 3). 
Sample programs are provided to demonstrate the unique features of the supported 
devices.

1.2 DEVELOPMENT KIT CONTENTS

The PICDEM 2 Plus Demonstration Board kit comes with the following:

• PICDEM 2 Plus Demonstration Board (see Figure 1-1)

• Sample devices (pre-loaded with program demonstration)

If you are missing any part of the kit, please contact your nearest Microchip sales office 
listed in the back of this publication for help.

1.3 PICDEM™ 2 PLUS DEMONSTRATION BOARD

The PICDEM 2 Plus Demonstration Board has the following hardware features:

1. 18-, 28- and 40-pin DIP sockets
(although three sockets are provided, only one device may be used at a time)

2. On-board, +5V regulator for direct input from 9V, 100 mA AC/DC wall adapter or 
9V battery, or hooks for a +5V, 100 mA regulated DC supply

3. RS-232 socket and associated hardware for direct connection to an RS-232 
interface

4. Programmer/debugger connectivity supporting MPLAB® ICD 3, MPLAB REAL 
ICE and PICkit 3

5. PICkit Serial Connector for analysis of serial communications peripherals such 
as SPI or I2C™

6. 5 k pot for devices with analog inputs

7. Three push button switches for external stimulus and Reset

8. Power-on indicator LED

9. Four LEDs connected to PORTB

10. On-board external oscillators including:

a) Unpopulated DIP socket for canned crystal oscillator (Y2)

b) RC oscillator circuit (R4, C3)

c) Unpopulated holes for crystal connection (Y1)

d) 32.768 kHz crystal for Timer1 clock operation (Y3)
DS40001584C-page 10  2011-2015 Microchip Technology Inc.



Introduction
11. 32K x 8 Serial EEPROM

12. LCD display

13. Piezo buzzer

14. Prototype area for user hardware

15. Expansion Header for PICtail™ daughter card connectivity or user access to 
MCU pins

16. Microchip TC74 thermal sensor

FIGURE 1-1: PICDEM 2 PLUS DEMONSTRATION BOARD HARDWARE
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1.4 ON-BOARD JUMPER CONFIGURATIONS

Most of the on-board components have associated jumpers that will allow the user to 
either connect or disconnect a component(s) from the PIC® MCUs or other mounted 
components. Table 1-1 and Figure 1-2 detail these connections.

FIGURE 1-2: PICDEM™ 2 PLUS DEMONSTRATION BOARD JUMPER 
LOCATIONS

1.5 SAMPLE DEVICES

Two Flash devices are included. The device types may change, but will generally 
include PIC16 and PIC18 40-pin, DIP devices.

TABLE 1-1: ON-BOARD JUMPER CONNECTIONS

Jumper Connection 

J6 LEDs to PORTB

J7 On-board RC oscillator to PIC® MCUs

J9 Piezo buzzer to RC2 pin (*on 40-pin mid-range device, this is CCP1)

J10 VCAP connection for devices with on-chip voltage regulator

J12 2.7V source to RA1 (voltage divider off of 9V input voltage)

J14, 15, 16, 17 PICkit™ Serial Header to I2C™ bus

J18,19 Tx and Rx from RS-232 components to PIC® MCUs

J20, 21, 22, 23 PIC® MCUs to I2C™ bus

J24 RA4 pin to RC2 pin (*on 40-pin mid-range device, this connects C1OUT to 
CCP1)
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1.6 SAMPLE PROGRAMS

The PICDEM™ 2 Plus Demonstration Board kit sample demonstration programs can 
be found on the Microchip web site (www.microchip.com/PICDEM2PLUS). These 
programs may be used with the included sample devices, with a REAL ICE (In-Circuit 
Emulator), MPLAB® ICD 3 (programmer/debugger) or with a PICkit™ 3 
(programmer/debugger). For each type of device (PIC16 or PIC18), the demo source 
code (several .C and .H files) and the compiled code (one .hex file) are provided.
 2011-2015 Microchip Technology Inc. DS40001584C-page 13
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Chapter 2.  Getting Started
The PICDEM™ 2 Plus Demonstration Board may be used as a stand-alone board with 
a preprogrammed device, with an In-Circuit Emulator (ICE), with an In-Circuit 
Debugger (ICD) or with a PICkit™ programming device. For a list of PIC® 
microcontroller compatible ICEs, ICDs or PICkit programming devices, see the 
Development Systems Ordering Guide. 

2.1 PICDEM™ 2 PLUS DEMONSTRATION BOARD AS A STAND-ALONE BOARD 
– PREPROGRAMMED DEVICE

The PICDEM 2 Plus Demonstration Board may be demonstrated immediately by 
following the steps listed below:

• Place the preprogrammed sample device in the appropriate socket on the 
PICDEM 2 Plus Demonstration Board.

• Confirm the jumpers are populated/removed according to Table 2-1 below. 

• Connect the programmer/debugger. See Section 2.2 “Programming the 
Device”.

• Apply power to the PICDEM 2 Plus Demonstration Board. See 
Section 2.3 “Powering the Board”.

TABLE 2-1: JUMPER SETUP
DS40001584C-page 14  2011-2015 Microchip Technology Inc.



Getting Started
To reprogram the sample device, the following will be necessary:

• The program source code – the user source code may be used to program the 
device, or if this previously has been done, the sample program may be restored 
from the file included in the PICDEM 2 Plus installer.

• An assembler, such as MPASM™ assembler (available with MPLAB® X IDE), or a 
compiler, such as HI-TECH® C or MPLAB XC8 (PIC18 devices only).

The source code must be assembled or compiled into a hex file before it can be 
programmed into the device. Microchip Technology’s MPLAB XC8 may also be used. 
Both are compatible with MPLAB X IDE.

Other assemblers/compilers may be used. For a list of these PIC® MCU compatible 
language tools, see the Microchip web site (www.microchip.com).

Once the sample program is in hex file format, a programmer can program a Flash 
device. Microchip Technology’s PICkit or ICD 3 programmer may be used. Both are 
compatible with MPLAB X IDE. 

Other programmers may be used. For a list of these PIC MCU compatible 
programmers, see the Microchip web site (www.microchip.com).

If the code protection bit(s) have not been programmed, the on-chip program memory 
can be read out for verification purposes. 

2.2 PROGRAMMING THE DEVICE

The PICDEM 2 Plus Demonstration Board supports the ability to program a device 
through multiple options. 

2.2.1 PICkit Programming

FIGURE 2-1: PICkit™ PROGRAMMER AND BOARD CONNECTION 
HEADER

Microchip’s PICkit 3 In-Circuit Debugger/Programmer uses in-circuit debugging logic 
incorporated into each chip with Flash memory to provide a low-cost hardware 
debugger and programmer. 
 2011-2015 Microchip Technology Inc. DS40001584C-page 15
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2.2.2 ICD Programming

FIGURE 2-2: ICD PROGRAMMER AND BOARD CONNECTION HEADER

The MPLAB® ICD 3 In-Circuit Debugger System is Microchip’s most cost-effective, 
high-speed hardware debugger/programmer for Microchip Flash Digital Signal 
Controller (DSC) and microcontroller (MCU) devices. It debugs and programs PIC® 
Flash microcontrollers and dsPIC® DSCs with the powerful, yet easy-to-use graphical 
user interface of MPLAB X Integrated Development Environment (IDE). 

The debugger/programmer for the project can be selected while creating a new MPLAB 
X project. When a new project is created in MPLAB X, the tool is selected in the 
hardware selection process (Figure 2-3).

FIGURE 2-3: SELECT TOOL
DS40001584C-page 16  2011-2015 Microchip Technology Inc.
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MPLAB X also allows modification of project properties (Figure 2-4). We can configure 
the debugger by right clicking on the main project and selecting Properties.

FIGURE 2-4: MODIFY PROJECT PROPERTIES

Refer to the MPLAB® X IDE User’s Guide (DS50002027) for further details on creating 
a project. The MPLAB® Code Configurator (MCC) is a plugin tool for MPLAB X IDE 
which generates drivers for controlling and driving peripherals of PIC microcontrollers. 
It generates source and header files based on the selections made in the GUI and adds 
it to the active project to MPLAB X. 
 2011-2015 Microchip Technology Inc. DS40001584C-page 17
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To open the MCC plugin tool, Click on Tools -> Embedded and click on MPLAB Code 
Configurator as shown in the Figure 2-5.

FIGURE 2-5: OPEN MPLAB® X CODE CONFIGURATOR

Once the MCC tool is launched, the sections – Project Resources Area, Device 
Resources Area, Composer Area and Pin Manager Area are displayed. The sections 
of the MCC tool are as shown in the image Figure 2-6.

FIGURE 2-6: DIFFERENT SECTIONS OF THE MCC PLUGIN
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Refer to the MPLAB® Code Configurator User’s Guide (DS40001725) for further details 
on how to configure the system clock, Configuration bits and various peripherals for the 
project. 

2.3 POWERING THE BOARD

The PICDEM 2 Plus Demonstration Board supports the ability to power the board 
through multiple options. 

2.3.1 External 9V Connector

FIGURE 2-7: 9V EXTERNAL POWER SUPPLY

The PICDEM 2 Plus Demonstration Board can be powered with an external 9V power 
supply. 

• Connect 9V power supply to a wall outlet. 

• Connect to the board as shown in Figure 2-7. The on-board regulator will reduce 
the input voltage to 5V for safe PIC device operation.

2.3.2 External 9V Battery

FIGURE 2-8: 9V EXTERNAL BATTERY

The PICDEM 2 Plus Demonstration Board can be powered with an external 9V battery 
for a power supply. 

• Connect the 9V battery to the board [B]. 

• The on-board regulator will reduce the input voltage to 5V for safe PIC device 
operation. 
 2011-2015 Microchip Technology Inc. DS40001584C-page 19
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2.3.3 Power by Programmer

FIGURE 2-9: 5V SUPPLIED BY PROGRAMMER

The PICDEM 2 Plus Demonstration Board can also be powered with a PICkit or ICD 
programming device.

• Open Project Properties window. Select ICD 3/PICkit 3 under Categories. 

• Select Power from the Option Categories drop-down list.

• Click the checkbox if you want the tool to provide power to the target board. Select 
a voltage level from the list that the tool should provide the board.
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Chapter 3.  Tutorial
The tutorial program is preprogrammed into the sample device. The PIC16 device’s 
program was built using the MPLAB® X IDE and MPLAB® XC8 compiler along with 
MCC Plugin for MPLAB X IDE. These programs are included in the PICDEM™ 2 Plus 
installer file found at www.Microchip.com/PICDEM2PLUS.

In case the device has been reprogrammed to a user’s unique code, the device can 
always be reprogrammed with the tutorial program if installed.

For detailed information on the PICDEM 2 Plus hardware, please refer to Appendix 
A. “Hardware Detail”.

3.1 TUTORIAL PROGRAM OPERATION

The tutorial program is made up of four components, which are individually displayed 
on the LCD.

3.1.1 Voltmeter

FIGURE 3-1: VOLTMETER DISPLAY AND COMPONENT

This mode uses the A/D module to measure the voltage of the RA0 pot (R16) and 
displays a voltage between 0.00V and 5.00V on the LCD. 

Voltage is continually updated until the mode is exited by pressing RB0. 

FIGURE 3-2: VOLTAGE READINGS

Reading the Voltmeter Display (ADC)

A) (ADRESH:ADRESL) ADC conversion result. Range: 10-bit (0-1023).

B) Voltage representation. 
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3.1.2 Buzzer

FIGURE 3-3: BUZZER DISPLAY AND COMPONENT

This mode turns on the Piezo buzzer using the CCP1 module I/O pin, RC2.

FIGURE 3-4: FIGURE 3-4: BUZZER READINGS

The period and duty cycle of the CCP1 frequency can be changed while the buzzer is 
on. The changes in period are recognized immediately in the buzzer tone. By changing 
the period, the buzzer frequency changes.

• To change the period, press RB0 under the “Buzzer” menu.

• The buzzer will sound off with the default frequency of 10 kHz and a period of 05h 
(0%).

• By pressing the RB4 button the period will increase by 5 (2%). 

• The LCD will display the current Key being played by the buzzer based upon the 
period. 

• Press RB0 to exit the buzzer function.

Figure 3-3 shows an example of a signal supplied to the buzzer.

Reading the Buzzer Display (PWM)

A) PWM Period Percentage. Range (0-100%) Frequency (10 kHz-250 Hz). 

- Please refer to Table 3-1 for a index of Period, PWM%, Frequency and Key.

B) This is the key being played based on the frequency being supplied to the speaker. 

C) Increase the PWM period by 2%.
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FIGURE 3-5: BUZZER SIGNAL

TABLE 3-1: BUZZER INDEX
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3.1.3 Temperature

FIGURE 3-6: TEMPERATURE DISPLAY AND COMPONENT

This mode uses a TC74 thermal sensor to measure ambient temperature in Celsius 
and then display the temperature on the LCD. The user has the option to change the 
display between Celsius and Fahrenheit by pressing RB4.

Communication between the PIC® MCU and sensor is accomplished using the MSSP 
module. This mode is exited by pressing RB0. Ensure that Jumpers J22 and J23 
should be removed for I2C™ communication. 

FIGURE 3-7: TEMPERATURE READINGS

3.1.4 Clock

FIGURE 3-8: CLOCK DISPLAY

Reading the Temperature Display

A) Display current temperature at given unit of measurement 

B) Change the unit of measurement.
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The Real-Time Clock will start counting from 00:00:00 at the start of the program.

The Timer1 module and a 32 kHz clock crystal are used to establish a Real-Time Clock.

By pressing RA4 within the clock function, the clock time can be set to the user’s 
preference. The user has the option to set the hours or minutes of the clock. 

FIGURE 3-9: INCREMENT/DECREMENT HOURS

By pressing RA4 within the set function, the user can set the hours. The user first has 
the option to increment the hours, one hour at a time by pressing RA4. If the user 
presses RB0 within the increment hour’s function, the program will then allow the user 
to decrement the hours, one hour at a time by pressing RA4. When the user presses 
RB0 again the program will return to the clock display screen. 

FIGURE 3-10: INCREMENT/DECREMENT MINUTES

By pressing RB0 within the set function, the user can set the minutes. The user first has 
the option to increment the minutes, one minute at a time by pressing RA4. If the user 
presses RB0 within the increment minute’s function, the program will then allow the 
user to decrement the minutes, one minute at a time by pressing RA4. When the user 
presses RB0 again the program will return to the clock display screen. 
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3.1.5 USART

FIGURE 3-11: USART DATA

The data displayed on the LCD within all the program functions is also sent to the 
RS-232 serial port using the USART on the PIC MCU. A terminal emulator program on 
the PC will be able to display the same information that is displayed on the LCD. Ensure 
the jumpers J20 and J21 are not connected for USART communication.

3.2 SOURCE CODE AND APPLICATION NOTES

In addition to the assembled tutorial program (hex files), source code used to create 
these hex files are included in the PICDEM 2 Plus installer. Both source code and 
related hex files are found in device-specific directories.

A digital guide is also included with the installer.

For information on how to reprogram the device with new or modified code, or how to 
restore the tutorial program, please see Section 2.1 “PICDEM™ 2 Plus Demonstra-
tion Board as a Stand-Alone Board – Preprogrammed Device”.
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FIGURE 3-12: TUTORIAL PROGRAM FLOWCHART
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Appendix A. Hardware Detail
The PICDEM™ 2 Plus Demonstration Board hardware is extremely simple and 
illustrates the ease-of-use of various PIC® MCUs. This section describes the PICDEM 
2 Plus Demonstration Board hardware elements.

A.1 PROCESSOR SOCKETS

Although three sockets are provided, only one device may be used at a time.

• 18-pin socket

• 28-pin socket

• 40-pin socket

A.2 DISPLAY

• Four green LEDs are connected to PORTB of each processor type. 

• PORTB pins are set high to light the LEDs. These LEDs may be disconnected 
from PORTB by removing jumper J6.

• One red LED is provided to indicate whether there is power to the PICDEM 2 Plus 
Demonstration Board.

• LED On = Powered. LED Off = Not Powered

A.3 POWER SUPPLY

There are multiple ways to supply power to the PICDEM 2 Plus Demonstration Board:

• A 9V battery can be plugged into J8.

• A 9V, 100 mA unregulated AC or DC supply can be plugged into J2. A power 
supply can be purchased through Microchip, part #AC162039.

• A +5V, 100 mA regulated DC supply can be connected to the hooks provided. 

MPLAB ICD or PICkit™ programmer users may use the programmer to power the 
target board to 5V, up to 200 mA, if the MPLAB programmer is connected to the PC.

A.4 RS-232 SERIAL PORT

An RS-232, level-shifting IC has been provided with all the necessary hardware to 
support connection of an RS-232 host through the DB9 connector. The port is 
configured as DCE and can be connected to a PC using a straight-through cable. 

The PIC16/PIC18 RX and TX pins are tied to the RX and TX lines of the MAX232A.
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A.5 SWITCHES

Three switches provide the following functions:

• S1 – MCLR to hard reset the processor

• S2 – Active-low switch connected to RA4

• S3 – Active-low switch connected to RB0

Switches S1 and S3 have debounced capacitors, where as S2 does not, allowing the 
user to investigate debounced techniques. 

When pressed, the switches are grounded. When idle, they are pulled high (+5V).

A.6 OSCILLATOR OPTIONS

• 32.768 kHz (watch-type) crystal for Timer1.

• Space for a user defined canned crystal oscillator.

• Space for a user defined oscillator crystal.

A.7 ANALOG INPUT

A 5Ω potentiometer is connected through a series 470Ω resistor to AN0. 

The pot can be adjusted from VDD to GND to provide an analog input to the parts with 
an A/D module. 

A.8 ICD CONNECTOR

By way of the modular connector (J5), the MPLAB ICD can be connected for low-cost 
debugging. The ICD connector utilizes RB6 and RB7 of the microcontroller for in-circuit 
debugging.

A.9 PICkit™ CONNECTOR

By way of the header connector (J11), the MPLAB PICkit can be connected for low-cost 
debugging.

A.10 TEMPERATURE SENSOR

This is a serial digital thermal sensor (TC74) connected to the 28- and 40-pin 
microcontrollers via RC3 and RC4. 

Communication is accomplished with the TC74 via its 2-wire I2C™ compatible serial 
port. This device has an address of ‘0b1001101’. 

A.11 SERIAL EEPROM

A 24L256 (32K x 8) serial EEPROM is included on the board to illustrate I2C bus 
concepts.

A.12 LCD

An LCD display with two lines, 16 characters each, is connecting to the 28 and 40-pin 
sockets. There are three control lines (RD6:RD4) and four data lines (RD3:RD0). 
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A.13 SAMPLE DEVICES

A sample part programmed with a simple program is included in the PICDEM 2 Plus 
Demonstration Board kit. Table A-1 lists the I/O features and port connections for each 
processor type.

TABLE A-1: PORT CONNECTIONS

Device LEDs RS-232 S1 S2 S3
Pot 
R16

LCD EEPROM Buzzer ICD
Temp 

Sensor
Y1/Y2

18-pin RB3:RB0 N/A MCLR RA4 RB0 RA0 N/A N/A N/A RB6/RB7 N/A Yes

28-pin RB3:RB0 RC6/RC7 MCLR RA4 RB0 RA0 N/A RC3/RC4 RC2 RB6/RB7 RC3/RC4 Yes

40-pin RB3:RB0 RC6/RC7 MCLR RA4 RB0 RA0 RD6:RD4
RD3:RD0

RC3/RC4 RC2 RB6/RB7 RC3/RC4 Yes
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A.14 BOARD LAYOUT AND SCHEMATICS

The following figures show the part layout (silkscreen) and schematics for the PICDEM 
2 Plus Demonstration Board.

FIGURE A-1: PICDEM™ 2 PLUS DEMONSTRATION BOARD PARTS LAYOUT
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FIGURE A-2: PICDEM™ 2 PLUS DEMONSTRATION BOARD SCHEMATIC
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FIGURE A-3: PICDEM™ 2 PLUS PIC16F1937 PINOUT
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FIGURE A-4: PICDEM™ 2 PLUS PIC18F86K22 PINOUT
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